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Preface 
Welcome to Investintech.com Inc. Software Development Kit (SDK). This SDK provides 
technologies for converting PDF files into other file formats as well as viewing PDF files. This 
user’s guide provides the basic information needed to use all parts of the SDK. This SDK consists 
of: 

�  Able2Extract Command Line, a console (command line) program for converting PDF 
files to other file formats 

�  Investintech PDF Viewer Control, an ActiveX control for viewing PDF files 

�  Investintech Conversion DLL, a Dynamic-Link Library for converting PDF files 

All these components are thoroughly covered in this documentation. 

About This Documentation 
This documentation consists of three major parts: 

�  Part 1: Able2Extract Command Line (A2ECL), describes purpose, installation and usage 
of command-line program that allows users to convert PDF files into various formats 
(Excel, RTF, CVS, HTML, plain text). 

�  Part 2: Investintech PDF Viewer Control, describes an ActiveX control that allows users 
to view PDF files. Installation and usage are thoroughly covered, as well as all the 
control’s methods. 

�  Part 3: Investintech Conversion DLL, describes usage and methods of DLL designed to 
convert PDF files into various formats (Excel, RTF, CVS, HTML, plain text). 

Typographical Conventions Used in This Document 
The following table describes typographical and naming conventions used in this document: 

Font Used for Examples 

monospaced Expected input from the user a2ecl - pdf2text abc.pdf 
abc.txt 

 Paths and filenames c:\a2ecl\a2ecl.exe 

 Source code MessageBox("ABC"); 

monospaced 
blue 

Source code keywords if 

monospaced 
green 

Source code comments //this is a comment 
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Font Used for Examples 

monospaced 
bold 

Method name The AboutBox()  method 

‘Single quoted bold’  Elements of the user interface like 
buttons, icons etc. 

click on ‘Start’ button, press ‘Enter’  

blue underlined Internet links http://www.investintech.com 

 

Getting More Information 
Investintech.com Inc. conducts research in data conversion technology and develops data 
conversion products utilizing results of the research. More information about our company is 
available at the company’s website http://www.investintech.com. 

Customer Service and Technical Support 
Investintech.com Inc. strives to provide the best possible technical support to its customers 

and prospective customers. If you would like personal assistance, please feel free to call us or 
send e-mail to Customer Service or Technical Support. We are available by phone during regular 
business hours and in the vast majority of cases, we will return our e-mail with an answer the 
same day it is received. 

 Customer Service Technical Support 

Telephone: +1 416 920 5884 +1 416 920 2539 

E-mail: keith.bradbury@investintech.com techsupport@investintech.com 

Hours: Our Business Hours are Monday to Friday 9am-6pm (Eastern Time GMT-5:00).  

Fax and Mailing Address 

Mailing Address: Investintech.com Inc. 

 410-96 Spadina Avenue 

 Toronto, ON 

 M5V 2J6 Canada 

Fax: +1 416 920 5848 



Preface 

Investintech.com Inc. SDK User's Guide 3 

Investintech.com Inc.  
Software Development Kit 
User’s Guide 
   PPPaaarrr ttt    111:::    AAA bbb lll eee222EEExxx ttt rrr aaaccc ttt    CCCooo mmm mmm aaannn ddd    LLL iii nnn eee   (((AAA 222EEECCCLLL )))     
 



Part 1: Able2Extract Command Line (A2ECL)   

4 Investintech.com Inc. SDK User's Guide 

What is Able2Extract? 
Able2Extract is stand-alone software application, with graphical user interface (GUI), that 
enables users to convert data from PDF, HTML and text file formats into Excel, Word, HTML 
and text file formats. 

Demo version of Able2Extract (GUI) is available, free of charge, for download from our 
company website, http://www.investintech.com 

What is Command Line? 
Microsoft Windows operating system is graphical user interface (GUI) operating system – 
commands are usually given by using mouse to interact with graphical elements on screen and 
results are visible through changes on graphics drawn on computer screen. Microsoft DOS is 
command line interface operating system – commands are typed on keyboard, executed when 
‘Enter’ key on keyboard is pressed and results are visible in text mode on screen. 

While GUI is generally better way of using computers, there are few cases where command 
line is much better solution for particular need – like when we want to repeat same command 
over and over again. 

In order to get command line interface window in any version of Windows, click on ‘Start’ 
(usually at lower left side of screen), point to ‘All Programs’, then point to ‘Accessories’ and 
click on ‘Command Prompt’ (or ‘MS DOS Prompt’ in older versions of Windows). 

What is Able2Extract Command Line? 
Able2Extract Command Line (A2ECL) is command line, shell or batch version of Able2Extract. 
With it, conversion of the large number of documents can be automated very simply and easily. 
A2ECL conversion is equivalent to A2E GUI conversion when ‘Edit > Select All’ menu option 
is used to select the whole document for conversion. 

Demo version of Able2Extract Command Line, due to copyright protection concerns, is not 
available for download from our company website. It is available, free of charge, by contacting 
Investintech.com Inc. and requesting the copy of it. 

Also, the conversions available in different releases of A2ECL vary, depending on what 
conversions you have requested to test (due to copyright protection concerns). At the moment, 
every release of A2ECL is custom prepared for each customer. 
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Installation Instructions for A2ECL 
Below you will find step-by-step instructions to install Able2Extract Command Line (A2ECL) on 
your system. You may want to print this instruction sheet for reference before beginning to install 
A2ECL. 

System Requirements 
Your computer system must meet these requirements as a minimum to install and run A2ECL: 

�  Microsoft Windows 98/Me/2000/XP/2003 

�  64 MB of RAM 

�  4 MB of available hard disk space 

Your computer system should meet these recommended requirements in order to use A2ECL 
comfortably: 

�  Microsoft Windows 98/Me/2000/XP/2003 

�  512 MB of RAM 

�  100 MB of available hard disk space 

Starting the Installation 

To start the installation just start InstallAble2ExtractCL.exe  file, e.g. by double 
clicking it in the Windows Explorer. After that you should see window that looks like this: 

Click the ‘Next’ button to continue installation. You should see the next window: 
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Read Investintech Software License Agreement carefully and thoroughly. If you want to continue 
with installation, choose ‘I agree with the above terms and conditions’ and click ‘Next’. 
Otherwise, click ‘Exit ’ and installation will terminate. If you clicked ‘Next’ you should see the 
next window: 

On this screen you have to decide where do you want to install A2ECL software. The default 
installation folder will be Program Files  folder on your system disk. It is possible to change 
installation folder either by typing its path directly or by clicking the ‘...’ button. The destination 
folder (directory) probably does not already exist, but the installation program will create it if 
necessary. Click the ‘Next’ button to continue the installation. 
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Click ‘Yes’ to create the destination directory and you should see the next window: 

Clicking the ‘Start’ button will start the installation. After a very short period of time, usually 
about 30 seconds, you should see the next window: 
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The installation is now finished. Click ‘View A2E CL Help.doc’ if you want to see help file or 
click ‘Exit ’ to finish the installation. 

Using A2ECL 
This section provides detailed information about using A2ECL software. Following topics are 
covered: 

�  using A2ECL from command prompt 

�  using A2ECL for batch conversion 

Using A2ECL From Command Prompt 
Prior to using A2ECL, you must open command prompt window. This could be done in two 
ways. Assumption is that you are using Windows XP. 

�  Click the ‘Start’ button, then point to ‘All Programs’, then point to ‘Accessories’ and 
finally point and click to the ‘Command Prompt’, or 

�  Click the ‘Start’ button, point and click to the ‘Run’ and type cmd 

If you have done this correctly the window titled “Command Prompt” or “cmd” should open, as 
shown. 
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Now you need to navigate to folder in which A2ECL is installed. In this example we will assume 
that it is D:\Program Files\Able2ExtractCL . You should type sequence of commands 
as shown below. If you have any troubles, please refer to MS DOS manual or Windows help. 

 

To display short help about A2ECL, simply type a2ecl  and press ‘Enter’. You will see how to 
use it, some examples and possible conversion types. You may enter only one form of command: 
a2ecl -conversion_type input_file output_file 

Conversion type 

This parameter determines source and destination file formats. Source file is the file you want to 
convert. Destination file is the file in which results of the conversion will be put into. It is 
important to know that the source file will remain intact. Possible source file formats are Portable 
Document Format (PDF) and plain text. Possible destination file formats for PDF source are 
Microsoft Excel (XLS), Rich Text Format (RTF), Hyper Text Markup Language (HTML), 
Comma Separated Values (CSV) and plain text. Possible destination format for plain text source 
is XLS. 

Following table shows all possible values of the -conversion_type  parameter: 

Conversion type Description 

-pdf2excel Converts PDF file to Excel 2.1 file so any version of Microsoft Excel can 
open destination file. 

-pdf2rtfS Converts PDF file to RTF file so any version of Microsoft Word and 
WordPad can open destination file. This conversion option will only convert 
the text portions of selected items. The text will appear as a standard 
paragraph without special formatting or text boxes in a new Word document. 
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This conversion is most useful when preserving the look and feel of the PDF 
in RTF format is not important, but the user desires easy access to the text 
information. Resulting RTF file can be saved as Microsoft Word DOC file. 

-pdf2rtfF Converts PDF file to RTF file with frames so any version of Microsoft Word 
can open destination file. In this case the most precise conversion algorithm 
is used. This conversion option will result in the converted RTF output 
retaining the background graphics and layout of the selected pages and 
items, but with the text appearing in individual text boxes in a new 
document. This conversion is ideal for users that prefer to work with text 
boxes which can be easily moved within a document. Under certain 
circumstances, because the text boxes are designed to correlate with the 
structural positioning of the original PDF document, it may be possible to 
generate a more accurate layout than with the -pdf2rtfS conversion selection 
option. Resulting RTF file can be saved as Microsoft Word DOC file. 

-pdf2rtfN Converts PDF file to common RTF file so any version of Microsoft Word 
can open destination file. This is the most appropriate option for editing 
following conversion. Resulting RTF file can be saved as Microsoft Word 
DOC file. 

-pdf2csv Converts PDF file to CSV file so virtually all spreadsheet programs can 
open destination file. 

-pdf2html Converts PDF file to Hyper Text Markup Language (HTML) format so all 
web browsers can open destination file. 

-pdf2text Converts PDF file to plain text file so any text editor can open destination 
file. 

-text2excel Converts plain text file to Excel 2.1 file so any version of Microsoft Excel 
can open destination file. 

Input file 

This argument determines the source file, i.e. the file you want to convert data from. Please pay 
attention to following: 

�  You must write both file name and extension separated with dot. For example, file 
business.pdf  consists of file name ‘business ’ and extension ‘pdf ’. 

�  You must provide full path to the input file unless it is in the same folder as a2ecl.exe . 
For example, if input file business.pdf  is in MyFiles  folder on C drive, you should 
type c:\MyFiles\business.pdf  as an input file argument. If any folder name or 
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file name in the path is longer than 8 characters or contains spaces you must surround its 
path with double quotation marks, e.g. "c:\very long path\business.pdf" 

Output file 

This argument determines the destination file, i.e. the file in which results of the conversion will 
be put into. Same path and file name rules apply for output file as well as for input file. 

Examples of Using A2ECL 
Here you will find how to use A2ECL through few examples. 

Example #1 

In this example we will assume that both input and output files are in the same folder as A2ECL. 
If you type a2ecl -pdf2excel license.pdf license.xls and press ‘Enter’,  you 
will convert from PDF to XLS file. The resulting XLS file can be opened by any version of 
Microsoft Excel. The picture below shows a successful conversion. For each converted page 
A2ECL will print “|” on the screen to let user know that it is active and working. 

Example #2 

In this example we will assume that input file is in the same folder as A2ECL, but we want 
output file to be created in the different folder, e.g. d:\conv . Plus, we want the output file to be 
RTF and to use the most precise conversion. If you type a2ecl -pdf2rtfF license.pdf 
d:\conv\license.rtf and press ‘Enter’, you will convert from PDF to RTF file. The 
picture below shows a successful conversion. 
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Example #3 

In this example we will assume that neither input nor output file is in the same folder as A2ECL. 
Input file is in d:\src  folder and we want output file to be created in the d:\conv . Plus, we 
want the output file to be plain text. If you type a2ecl -pdf2text 
d:\src\license.pdf d:\conv\license.txt and press ‘Enter’, you will convert 
from PDF to text file. The picture below shows a successful conversion. 

Example #4 

In this example we will assume that neither input nor output file is in the same folder as A2ECL. 
Input file is in d:\src  folder and we want output file to be created in the d:\conversion 
result . Plus, we want the output file to be plain text. If you type a2ecl -pdf2text 
d:\src\license.pdf "d:\conversion result\license.tx t" and press 
‘Enter’, you will convert from PDF to text file. The picture below shows a successful 
conversion. 
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Using A2ECL for Batch Conversion 
With A2ECL it is possible to convert a number of files by typing just one command. This is done 
through the batch processing, a technique existing in MS DOS and in MS Windows command 
prompt. For example, if you want to convert all PDF’s to XLS files, create a batch file with just 
one line: FOR %%f IN (*.PDF) DO a2ecl -pdf2excel "%%f" "%%f.x ls" 

If you save this file as batchcnv.bat  and put it in the same folder with A2ECL, you could 
easily convert all PDF files to XLS files in that folder by typing batchcnv . 

To convert files from different folders create a batch file like this one: 

@echo off 
title My Batch Conversion 
set srcdir=d:\src 
set dstdir=d:\conversion result 
if not exist "%dstdir%\" md "%dstdir%\" 
if not errorlevel 1 FOR %%f IN (*.PDF) DO a2ecl -pd f2excel 
"%srcdir%\%%f" "%dstdir%\%%f.xls" 

This will convert all PDF files from d:\src  folder to XLS files and write converted files in 
d:\conversion result  folder. If d:\conversion result  folder does not exist, it 
will be created. Files in d:\src  folder will remain unchanged. It is easy to choose different 
source and/or destination folder, simply by changing values of srcdir  and dstdir  variables. 
For example, to convert files from c:\myfiles  folder instead of d:\src , just change third 
line in the above batch to set srcdir=c:\myfiles . 

For more information on batch files please refer to MS DOS manual. 

Troubleshooting 
There are a couple of situations in which A2ECL is not able to convert file as requested. Please 
consult following table if you experience any of errors while working with A2ECL. 
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Error Cause Solution 

Input file is non-existent 
or non-accessable! 

Misspelled file name or file path. 
Less likely, you do not have 
permissions to access input file. 

Correct spelling error or contact 
your system administrator to give 
you permissions to read input file. 

Input file is damaged or 
not valid PDF file! 

Input file was found but it either is 
not PDF file or it is damaged or 
corrupted PDF file 

If Acrobat Reader can open the 
file without any error message 
please send the file to our 
technical support e-mail and we 
will look further into the problem. 
If Adobe Acrobat (full version) 
can open the file with error 
message, save the file back - this 
way Adobe Acrobat will repair 
the file. Then try conversion 
again. 
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What is Investintech PDF Viewer Control? 
The Investintech PDF Viewer Control is an ActiveX control. You can insert this control into your 
application and use it for accessing and viewing PDF files. 

Prerequisites 
Your computer system must meet these requirements as a minimum to use Investintech PDF 
Viewer Control: 

�  Windows XP 

�  some development environment, such as Microsoft Visual Studio or Borland Delphi 

Installation Instructions 
This section covers the installing of Investintech PDF Viewer Control. In order to install control, 
you will use regsvr32 program. This program is a part of Microsoft Windows XP. 

First of all, copy InvestintechPDFViewerControl.ocx  file in some folder. For 
example, that will be C:\ActiveX Controls  folder. This could be done through Windows 
Explorer or some file manager. Next, open command prompt window (if you don’t know how to 
do it, look at ‘UsingA2ECL From Command Prompt’ section in this document). Navigate to  
C:\ActiveX Controls  folder. Your window should look like this: 

Now type regsvr32 InvestintechPDFViewerControl.ocx  and press ‘Enter’. The 
process of registering control is done. You can now use Investintech PDF Viewer Control in your 
applications. 

Using Investintech PDF Viewer Control in Microsoft Visual 
C++.NET 2003 
In this section you will see how to make wrapper class around Investintech PDF Viewer Control. 
All pictures and examples from now on will be based on Microsoft Visual C++.NET 2003. 
Furthermore, we will use Microsoft Foundation Classes (MFC) to create that wrapper class. 
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Creating New Project and Adding Wrapper Class 
Start Visual Studio and select ‘File > New > Project’. In ‘ Project Types’ pane select Visual 
C++ projects and in ‘Templates’ pane select MFC Application. Type application name and click 
‘OK’. 

After that you should see the window titled “MFC Application Wizard”. The most important 
option to select is ‘ActiveX controls’ under Advanced Features: 
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After you click the ‘Finish’ button Application Wizard will make all necessary classes and 
resources. In the ‘Solution Explorer’ pane right click the Source Files folder and select 
‘Add > Add class...’ from context sensitive menu. Select ‘MFC Class From ActiveX Control’ 
and click the ‘Open’ button. You should see the window like this one: 

         

Choose InvestintechPDFViewerControl Control from ‘Available ActiveX controls’ drop down 
list. Then click on the ‘>’ button and on the ‘Finish’ button. You should see two new files in 
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your project: CDInvestintechPDFViewerControl.h  and 
CDInvestintechPDFViewerControl.cpp . 

The result of these operations is adding the wrapper class CDInvestintechPDFViewerControl 
to your project. Now you can create (instantiate) object of CDInvestintechPDFViewerControl 
type and use Investintech PDF Viewer Control through CDInvestintechPDFViewerControl 
methods. 

Investintech PDF Viewer Control Methods 
Interface of the Investintech PDF Viewer Control is exposed through its methods. In this section 
you will find details about each method: prototype, description, parameters,  return value, how to 
call a method and some examples of using methods. 

OpenPDF 
unsigned char  OpenPDF(LPCTSTR fileName, LPCTSTR openWithPassword ) 

Description 

The OpenPDF()  method opens a PDF file. 

Parameters 

fileName The name of the file you want to open. 

openWithPassword The password used to open file if the file is password 
protected; otherwise empty string. 

Returns 

Non zero value if file is opened successfully, zero otherwise. 

Example 

CFrameWnd* parentWnd = new CFrameWnd();  
static char  BASED_CODE szFilter[] = "PDF Files (*.pdf)|*.pdf";  
CString strPathName; 
CFileDialog dlg( true , "pdf", NULL, OFN_HIDEREADONLY | 
OFN_OVERWRITEPROMPT, szFilter, this , 0); 
if  ( IDCANCEL == dlg.DoModal() ) 
 return ; 
strPathName = dlg.GetPathName(); 
//create a viewer control dynamically 
CDInvestintechPDFViewerControl* pViewer = new 
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CDInvestintechPDFViewerControl(); 
CRect rect; 
GetClientRect(&rect); 
// create a view to occupy the client area of the f rame 
if  ( !pViewer->Create(NULL, NULL, AFX_WS_DEFAULT_VIEW , rect, 
parentWnd, AFX_IDW_PANE_FIRST, NULL) ) { 
 MessageBox("Failed to create viewer window!"); 
 delete  pViewer; 
 return  ; 
} 
else  { //creation successful  
 pViewer->OpenPDF(strPathName, _T("")); 
 pViewer->BringWindowToTop(); 
} 

GetPageCount 
unsigned  char  GetPageCount() 

Description 

The GetPageCount()  method counts number of pages in PDF file. 

Parameters 

None. 

Returns 

Total number of pages in PDF file. 

GetCurrentPage 
unsigned  long  GetCurrentPage() 

Description 

The GetCurrentPage()  method is used to obtain page number of currently viewed page in 
PDF file. 

Parameters 

None. 
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Returns 

Page number of currently viewed page. 

GoToPage 
unsigned  char  GoToPage( unsigned  long  pageNumber) 

Description 

The GoToPage()  method is used to go directly to some page in PDF file. 

Parameters 

pageNumber Number of page that will be shown. 

Returns 

Non zero value if PDF file has at least as many pages as pageNumber , zero otherwise. 

Example 

//assuming that CDInvestintechPDFViewerControl* pVi ewer is 
successfully created //and some PDF file is opened  
unsigned char  numberOfPages; 
unsigned long  pageNumber = 42; 
numberOfPages = pViewer->GetPageCount(); 
if  (pageToGo <= numberOfPages) 
 pViewer->GoToPage(pageNumber); 
else  
 MessageBox("There is no page 42 in this PDF."); 

GetCurrentZoomRatio 
double  GetCurrentZoomRatio() 

Description 

The GetCurrentZoomRatio()  method gets current zoom ratio of PDF file. 

Parameters 

None. 
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Returns 

Current zoom ratio of PDF file as floating point double value. For example, if zoom is set to 
75%, returned value will be 0.75 and if zoom is set to 200%, returned value will be 2.00. 

SetZoom 
unsigned  char  SetZoom(LPCTSTR zoomRationOrDescription) 

Description 

The SetZoom()  method sets desired zoom on PDF file. 

Parameters 

zoomRationOrDescription  String containing zoom percentage. It must have %2.2f%% 
format, for example 33.33% or 150%. It is also possible to 
use Fit Width, Fit Page and Actual Size strings to fit page 
width to window, to fit page height to window or to display 
page in actual size (i.e. zoomed to 100%). 

Returns 

Non zero value if zoom ratio is set successfully, zero otherwise. 

Example 

//assuming that CDInvestintechPDFViewerControl* pVi ewer is 
successfully created //and some PDF file is opened  
double  currentZoomRatio; 
Cstring zoomDescription; 
currentZoomRatio = pViewer->GetCurrentZoomRatio(); 
strZoom.Format("%2.2f%%", currentZoomRatio*2); 
if (pViewer->SetZoom(strZoom) != 0) 
 //zoom is successfully doubled  
 currentZoomRatio = pViewer->GetCurrentZoomRatio();  

RotateView 
unsigned  char  RotateView( short  rotateViewDegrees) 

Description 

The RotateView()  method rotates PDF file. 
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Parameters 

rotateViewDegrees Number of degrees that PDF file will be rotated for. 

Returns 

Non zero value if file is rotated successfully, zero otherwise. 

AboutBox 
void  AboutBox() 

Description 

The AboutBox()  method displays information window about InvestintechPDFViewerControl. 

Parameters 

None. 

Returns 

None. 

Example 

CDInvestintechPDFViewerControl* pViewer = new 
CDInvestintechPDFViewerControl(); 
pViewer->AboutBox(); 

ClosePDF 
unsigned  char  ClosePDF() 

Description 

The ClosePDF()  method closes a PDF file. 

Parameters 

None. 

Returns 

Non zero value if file is closed successfully, zero otherwise. 
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Example 

//assuming that CDInvestintechPDFViewerControl* pVi ewer is 
successfully created //and some PDF file is opened 
if  (pViewer->ClosePDF() != 0) 
 MessageBox("PDF is successfully closed!"); 
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What is Investintech Conversion DLL? 
The Investintech Conversion DLL is a collection of methods compiled, linked and stored in a 
dynamic-link library (DLL) file. Purpose of these methods is converting files from PDF to 
Microsoft Excel (XLS), Rich Text Format (RTF), Comma Separated Values (CVS), Hyper Text 
Markup Language (HTML) and plain text formats. 

Prerequisites 
Your computer system must meet these requirements as a minimum to use Investintech 
Conversion DLL: 

�  Windows XP 

�  some development environment, such as Microsoft Visual Studio or Borland Delphi 

Using Investintech Conversion DLL in Microsoft Visu al C++ 
.NET 2003 
In this section you will see how to use Investintech Conversion DLL. All pictures and examples 
from now on will be based on Microsoft Visual C++ .NET 2003. 

In order to use methods contained in DLL you have to link an executable file to DLL. 
Executable file can be either EXE or DLL file. There are two possible ways of linking: implicit 
and explicit linking. In this documentation implicit linking will be shown. 

Implicit Linking 
Implicit linking is load-time linking. The following is needed for executables to implicitly link to 
Investintech Conversion DLL: 

�  InvestintechConversionDLL.h , the header file which contains declarations of 
exported methods 

�  InvestintechConversionDLL.lib , an import library to link with 

�  InvestintechConversionDLL.dll , actual DLL file 

All these files are provided by Investintech.com Inc. 

Linking .lib file with project 

Below you will find step-by-step instructions on how to link 
InvestintechConversionDLL.lib  file with your project. 
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Start Visual Studio and select ‘File > Open > Project’. Select the project in which you want 
to use InvestintechConversionDLL.dll  and click ‘OK’. Select ‘Project > Properties’. 
You should see the window like next one: 

 

Click the ‘Linker ’ folder and open ‘Input ’ property page. Modify the ‘Additional 
Dependencies’ property by clicking the ‘...’ button. 
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The window titled “Additional Dependencies” should open: type InvestintechConversionDLL.lib 
and click the ‘OK’ button. Click ‘OK’ to close “Property Pages” window. You have successfully 
linked InvestintechConversionDLL.lib  with your project. 

Using methods from DLL file 

After linking with InvestintechConversionDLL.lib file you can use methods contained in 
InvestintechConversionDLL.dll file. Simply include InvestintechConversionDLL.h file in all 
source files that need to use those methods. 

Investintech Conversion DLL Methods 
Interface of the Investintech Conversion DLL is exposed through its methods. In this section you 
will find details about each method: prototype, description, parameters,  return value, how to call 
a method and some examples of using methods. It is assumed that following lines precede each of 
the examples: 

//.h file must be included if we want to use conver sion methods  
#include  "InvestintechConversionDLL.h" 
BSTR bstr_inputFile; 
CString str_inputFile; 
//input file name  
str_inputFile = _T("in.pdf"); 
//conversion from CString to BSTR  
bstr_inputFile = str_inputFile.AllocSysString(); 
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InvestintechConversionDLL_PDF_to_Excel 
bool  InvestintechConversionDLL_PDF_to_Excel(BSTR BSTR_i nFile, 
BSTR BSTR_outFile) 

Description 

The InvestintechConversionDLL_PDF_to_Excel()  method converts file from PDF 
to Microsoft Excel 2.1 format. Any version of Microsoft Excel can open destination (output) file. 
Original PDF file will remain unchanged. 

Parameters 

BSTR_inFile String containing full path and filename or just filename of PDF file that will 
be converted to XLS file. 

BSTR_outFile  String containing full path and filename or just filename of XLS file 
representing the result of conversion. 

Returns 

true  if PDF file is successfully converted to XLS, false  otherwise. 

Example 

//CA2W converts from ANSI to UNICODE character stri ng 
InvestintechConversionDLL_PDF_to_Excel(bstr_inputFi le, 
CA2W("out.xls")); 

InvestintechConversionDLL_PDF_to_HTML 
bool  InvestintechConversionDLL_PDF_to_HTML(BSTR BSTR_in File, BSTR 
BSTR_outFile) 

Description 

The InvestintechConversionDLL_PDF_to_HTML()  method converts file from PDF to 
HTML format. Any web browser can open destination (output) file. Original PDF file will 
remain unchanged. 

Parameters 

BSTR_inFile String containing full path and filename or just filename of PDF file that will 
be converted to HTML file. 

BSTR_outFile  String containing full path and filename or just filename of HTML file 



Part 3: Conversion DLL   

30 Investintech.com Inc. SDK User's Guide 

representing the result of conversion. 

Returns 

true  if PDF file is successfully converted to HTML, false  otherwise. 

Example 

InvestintechConversionDLL_PDF_to_HTML(bstr_inputFil e, 
CA2W("out.html")); 

InvestintechConversionDLL_PDF_to_Text 
bool  InvestintechConversionDLL_PDF_to_Text(BSTR BSTR_in File, BSTR 
BSTR_outFile) 

Description 

The InvestintechConversionDLL_PDF_to_Text()  method converts file from PDF to 
plain text format. Any text editor can open destination (output) file. Original PDF file will remain 
unchanged. 

Parameters 

BSTR_inFile String containing full path and filename or just filename of PDF file that will 
be converted to plain text file. 

BSTR_outFile  String containing full path and filename or just filename of plain text file 
representing the result of conversion. 

Returns 

true  if PDF file is successfully converted to plain text, false  otherwise. 

Example 

InvestintechConversionDLL_PDF_to_Text(bstr_inputFil e, 
CA2W("out.txt")); 

InvestintechConversionDLL_PDF_to_RTF_Normal 
bool  InvestintechConversionDLL_PDF_to_RTF_Normal(BSTR 
BSTR_inFile, BSTR BSTR_outFile) 
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Description 

The InvestintechConversionDLL_PDF_to_RTF_Normal()  method converts file 
from PDF to RTF file.  Usage of this method will retain background graphics, as a background 
image in the converted output, and the textual layout using the layout of the original PDF 
document for guidance. For most documents, this will provide the best looking output in a format 
that is simple to edit. As such, it is the recommended format for most documents. Original PDF 
file will remain unchanged. 

Parameters 

BSTR_inFile String containing full path and filename or just filename of PDF file that will 
be converted to RTF file. 

BSTR_outFile  String containing full path and filename or just filename of RTF file 
representing the result of conversion. 

Returns 

true  if PDF file is successfully converted to RTF, false  otherwise. 

Example 

InvestintechConversionDLL_PDF_to_RTF_Normal(bstr_in putFile, 
CA2W("out_std.rtf")); 

InvestintechConversionDLL_PDF_to_RTF_Frames 
bool  InvestintechConversionDLL_PDF_to_RTF_Frames(BSTR 
BSTR_inFile, BSTR BSTR_outFile) 

Description 

The InvestintechConversionDLL_PDF_to_RTF_Frames()  method converts file 
from PDF to RTF file with frames so any version of Microsoft Word can open destination file. In 
this case the most precise conversion algorithm is used. Usage of this method will result in the 
converted RTF output retaining the background graphics and layout of the selected pages and 
items, but with the text appearing in individual text boxes in a new document. This conversion is 
ideal for users that prefer to work with text boxes which can be easily moved within a document. 
Under certain circumstances, because the text boxes are designed to correlate with the structural 
positioning of the original PDF document, it may be possible to generate a more accurate layout 
than with the InvestintechConversionDLL_PDF_to_RTF_Normal()  method. 
Resulting RTF file can be saved as Microsoft Word DOC file. Original PDF file will remain 
unchanged. 
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Parameters 

BSTR_inFile String containing full path and filename or just filename of PDF file that will 
be converted to RTF file with frames. 

BSTR_outFile  String containing full path and filename or just filename of RTF file with 
frames representing the result of conversion. 

Returns 

true  if PDF file is successfully converted to RTF, false  otherwise. 

Example 

InvestintechConversionDLL_PDF_to_RTF_Frames(bstr_in putFile, 
CA2W("out_frm.rtf")); 

InvestintechConversionDLL_PDF_to_RTF_Simple 
bool  InvestintechConversionDLL_PDF_to_RTF_Simple(BSTR 
BSTR_inFile, BSTR BSTR_outFile) 

Description 

The InvestintechConversionDLL_PDF_to_RTF_Simple()  method converts file 
from PDF to RTF file so any version of Microsoft Word and WordPad can open destination file. 
This conversion option will only convert the text portions of selected items. The text will appear 
as a standard paragraph without special formatting or text boxes in a new Word document. This 
conversion is most useful when preserving the look and feel of the PDF in RTF format is not 
important, but the user desires easy access to the text information. Resulting RTF file can be 
saved as Microsoft Word DOC file. Original PDF file will remain unchanged. 

Parameters 

BSTR_inFile String containing full path and filename or just filename of PDF file that will 
be converted to text-only RTF file. 

BSTR_outFile  String containing full path and filename or just filename of text-only RTF 
file representing the result of conversion. 

Returns 

true  if PDF file is successfully converted to RTF, false  otherwise. 
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Example 

InvestintechConversionDLL_PDF_to_RTF_Simple(bstr_in putFile, 
CA2W("out_txt.rtf")); 

InvestintechConversionDLL_PDF_to_CVS 
bool  InvestintechConversionDLL_PDF_to_CVS(BSTR BSTR_inF ile, BSTR 
BSTR_outFile) 

Description 

The InvestintechConversionDLL_PDF_to_CVS()  method converts file from PDF to 
Comma Separated Values (CVS) format. Original PDF file will remain unchanged. 

Parameters 

BSTR_inFile String containing full path and filename or just filename of PDF file that will 
be converted to CVS file. 

BSTR_outFile  String containing full path and filename or just filename of CVS file 
representing the result of conversion. 

Returns 

true  if PDF file is successfully converted to CVS, false  otherwise. 

Example 

InvestintechConversionDLL_PDF_to_CVS(bstr_inputFile , 
CA2W("out.cvs")); 

InvestintechConversionDLL_IDString 
char * InvestintechConversionDLL_IDString() 

Description 

The InvestintechConversionDLL_IDString()  method returns vendor’s ID string. 

Parameters 

None. 

Returns 

"Investintech Conversion DLL Version 3.00 by Investintech.com Inc." string.
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